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HOUDINI FOUNDATIONS

ワイングラスの粉砕 
このレッスンでは、ワイングラスを粉砕した後、時間を操作して液体（ワイン）を空中に保持します。このエフェクト
では、グラスの粉砕に RBD シミュレーション、ワインに流体シミュレーションを使用します。ダイナミクスネットワー
クをセットアップする方法と、シミュレーションを出力する方法を学習できます。ビジュアルエフェクトショットでは
たいてい、さまざまな種類のダイナミクスソルバを組み合わせて使用します。Houdini のダイナミクスネットワーク
は、多様なソルバを使い、それらによって 1 つのまとまった結果を得られるように設計されています。

また、Retime ノードを使用して、爆発が最大のときにシミュレーションの速度を落としてから、時間を逆戻りさせ
て始点に戻します。次にシミュレーションを Solaris/LOPS に移動し、ライトとカメラをセットアップした後、Karma 
レンダラを使用してショットをレンダリングします。  

レッスンの目標
弾丸がワイングラスに当たってグラスが割れ、液体が飛び散る様子を 
シミュレートします。

学習内容
	� ワイングラス、弾丸、液体のジオメトリをモデリングする方法
	� ブーリアンを使用してガラスジオメトリを事前に破壊する方法
	� グラスを粉砕する弾丸のリジッドボディシミュレーションを実行する方法
	� 液体が飛び散る FLIP 流体シミュレーションを実行する方法
	� シミュレーションをリタイムし、速度を落としてから、逆行させる方法
	� Solaris/LOPS で使用するために、結果を USD として 

エクスポートする方法
	� Solaris/LOPS でライトとマテリアルをセットアップする方法
	� Karma を使用して最終ショットをレンダリングする方法

使用する機能とソフトウェア
Houdini 19.5+ の機能を前提として、書かれています。

このレッスンの手順は、 
以下のHoudini 製品で実行可能です。
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プロジェクトファイル
SideFX.com の流体チュートリアルのページ

（このドキュメントを入手した場所です）から、
fluids_lesson_start  ディレクトリをダウン
ロードします。名前を fluids_lesson  に変更
し、Houdini Projects ディレクトリに配置し
てください。  

パート 1

ワイングラスのモデリング
まず、ポリゴンカーブを描画して回転させ、ワイングラスを作ります。 
Creasing（折り目）を使用してエッジを鋭くしたら、細分化して粉砕用に 
ジオメトリの密度をあげます。その後、ワイングラスからジオメトリを抽出し、 
液体のシミュレーションに使用する形状を作成します。 

最初のポイントを 
グリッドスナップ

2 つ目の 
ポイントを 
グリッドスナップ

最後の 4 つの 
ポイントを 
グリッドスナップ

Shift を 
押しながら、 
これら 4 つの
エッジを選択

01 File > Set Project を選択します。fluids_lesson  ディレクトリ
に移動し（上記の説明を参照）、Accept を押します。これにより、

このショットに関連するすべてのファイルがこのプロジェクトディレクトリと
そのサブフォルダに集められます。 

File > Save As... を選択します。新しい fluids_lesson ディレクトリが表示
されているはずです。ファイル名を wineglass_01.hip に設定し、Accept 
をクリックして保存します。これで、Tex  フォルダのリファレンス画像にアク
セスできるようになります。

02 Scene View で、V を押して Radial メニューを表示し、
Viewport Layout > Four Views を選択します。カーソルを 

Front  パネルの上に移動して、スペースバー + B を押して拡大します。

マウスがビューポート上にある状態で D を押します。Background タブ
をクリックし、Front タブで、ファイルピッカーを使用して $HIP、それから 
tex>wineglass_profile.jpg  に移動します。次のように設定します。

	� Auto-Place Image がオフであることを確認する
	� Image Offset を 0, 3 にする 
	� Image Scale を 5, 5 にする

これで、ビューをパンおよびドリーすると、背景も一緒に動きます。

03 Polygon シェルフで、Curve Polygon ツールをクリックします。
これにより、Primitive Type が Polygon に設定された Curve 

ノードが作成されます。X を押して Grid を選択し、グリッドスナッピングを
有効にして、ポイント A をクリックします。次に、同じようにグリッドポイント
の上にある 2 つ目のポイントをクリックします。グリッドスナッピングをオフ
にして、画像のトレースを続けます。

グラスのプレート部分（土台）の最後の 4 つのポイントでは、ずれないように
グリッドスナッピングをオンに戻します。ポイント B で終了したら、Enter を
押してカーブを完了します。グリッドスナッピングをオフにします。

オペレーションコントロールツールバーの Edit モードボタンをクリックする
と、ずれたポイントを移動できます。

04 スペースバー + B を押して、4 ビューのレイアウトに戻ります。
次に、マウスをパースビューの上に移動し、再度スペースバー 

+ B を押して拡大します。これで、カーブが 3D で表示されるようになりま
した。

S を押して Select ツールにしたら、N を押してカーブ上のすべてのプリミ
ティブを選択します。C を押して、Model > Curves > Revolve を選択しま
す。これで、ワイングラスのモデルになります。 

3 を押してエッジの選択に移り、カップの最上部（リム）のエッジをダブルク
リックします。Shift を押して、上から 2 番目のエッジとプレート（土台）の 
2 本のエッジをダブルクリックします。Tab > Crease を押して、Crease を 
0.75 に設定します。 
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09 4 を押して、プリミティブ選択に切り替え、N を押してすべての
プリミティブを選択します。C を押して、Model > Polygons > 

PolyExtrude を選択します。Distance を 0.01 に設定してワイングラスと
のオーバーラップを作成すると、液体を適切にレンダリングできます。 

ネットワークエディタで、チェーンの終端に Null ノードを追加して、 
その Display フラグを設定します。このノードの名前を FLUID_OUT  に 
変更します。 

オブジェクトレベルに上がり、このオブジェクトの名前を wine  に変更し
ます。 

05 4 を押して、プリミティブ選択に切り替え、N を押してすべて 
選択します。次に Tab > Subdivide を押します。Depth を 2 

に設定します。 

これにより、モデルが細分化されます（折り目が付けられたエッジは他の 
領域よりもシャープになるようセットアップされています)。Crease Weight 
を高くするとエッジは尖ります。このグラスでは、ソフトな見た目の方がうま
く機能します。

ネットワークエディタで、チェーンの終端に Null ノードを追加して、その 
Display フラグを設定します。このノードの名前を GLASS_OUT  に変更します。

オブジェクトレベルに戻り、オブジェクトの名前を wine_glass  に変更し
ます。 

06 wine_glass  ノードを選択した状態で、N を押してすべての 
プリミティブを選択します。次に、Modify シェルフに移動して、

Extract ツールをクリックします。これにより、ワイングラスジオメトリの 
objectmerge  が作成されるので、それを新しいオブジェクトに配置します。 

Front ビューから、ワイングラスの上部の面を選択して、Delete を押します。
すると、ネットワークに面を削除する Blast  ノードが追加されます。

注 : オリジナルのワイングラスのゴースト（半透明）表示バージョンが見える
のは、Scene View が Ghost Other Objects に設定されているからです。
この設定は、作業状況の前後関係を確認できるので便利です。

07 ここでパースビューに戻って、カップの下部をダブルクリックし、
Delete を押します。これにより、2 つ目の Blast ノードが追加さ

れます。これで、液体にしたい内側の面が残ります。ワインジオメトリの面
は、外側が暗く見えます。これは、そちら側がプリミティブの後面側というこ
とです。

N を押してすべてのプリミティブを選択します。Tab > Reverse を押して 
法線を外向きに反転させます。これで、各プリミティブの暗い側が形状の 
内側になります。

08 3 を押してエッジの選択に変更したら、形状のエッジをダブルク
リックして、開いたエッジを選択します。Tab を押して polyfill 

と入力します。Polyfill がハイライトされたら、Enter を押します。 

次のように設定します。
	� Fill Mode を Quadrilateral Grid にする
	� Tangent Strength を 0 にする 

これで閉じた形状が作成され、レッスンの後半で使用する FLIP 流体のソー
スになります。
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パート 2

弾丸のモデリング
弾丸のジオメトリを作成するためには、プリミティブの球から始め、それを半分にスライスします。次に、開口部を PolyExtrude で 
押し出したら、PolyFill で四角形トポロジを使用して形状を閉じます。その後、細分化して最終的な形状を定義します。 
このオブジェクトは非常に素早く移動するため、多くのディテールは必要ありません。  

1. LMB クリック

2. A を押して             
MMB クリック Delete を押す PolyFill で閉じる

01 オブジェクトレベルに移動し、ネットワークビューで、wine およ
び wine_glass  オブジェクトの Display フラグをオフにします。

Scene View で、C を押して、Create > Geometry > Sphere を選択します。
Enter を押して原点に配置したら、中に入って次のように設定します。

	� Orientation を X Axis にする
	� Radius を 0.2, 0.125, 0.125 にする
	� Columns を 12 にする

Scene View で Tab > Clip を押したら、N を押してすべてのプリミティブを
選択し、Enter を押して、Direction を 1, 0, 0 に設定します。 

02 Select ツールをクリックしたら、3 を押してエッジ選択を有効に
し、球の開口部をダブルクリックします。C を押して、Model > 

Polygons > PolyExtrude を選択します。  

Extrusion タブで、次のように設定します。
	� Transform Extruded Front をオンにする
	� Translate Z を 0.04 にする
	� Scale を 0.7, 0.7, 0.7 にする

これにより少しジオメトリが追加されます。この後、弾丸の前面の三角形を
削除して、形状を閉じます。

03 タンブルして、S を押して Select ツールにし、4 を押して 面 /プ
リミティブ選択にします。弾丸の先端で三角形の 1 つを選択し

たら、A キーを押しながら 2 つの三角形を MMB クリックして、三角形の面
をすべて選択します。Delete キーを押して、それらを削除します。これによ
り、ネットワークに Blast  ノードが追加されます。

ネットワークビューで、Tab > PolyFill を押して、blast  の後にそのノードを
追加します。Fill Mode を Quadrilateral Grid、Corner Offset を 1 に設
定し、Display フラグをオンにします。これにより、弾丸の両開口部が適切
な四角形トポロジで閉じられます。 

04 最後に Subdivide ノードを追加して、Depth を 2 にして、
Display フラグを設定します。 

ネットワークエディタで、チェーンの終端に Null ノードを追加して、その 
Display フラグを設定します。このノードの名前を BULLET_OUT  に変更し
ます。 

オブジェクトレベルに戻り、このオブジェクトの名前を bullet  に変更します。
wine_glass  の Display フラグをオンにします。弾丸を X 軸で -20、Y 軸で 
5、移動させます。Front  正射投影ビューに戻り、ワイングラスとの衝突ポイ
ントが意図した通りかどうかを確認するとよいでしょう。

作業内容を保存します。
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パート 3

ワイングラスの破砕
ワイングラスのひび割れを定義するために、Draw Curve ツールを使用して自然に見える線を作成し、それらを押し出してジオメトリの 
シートにします。次に、Mountain ツールを使用してサーフェスにノイズを加えます。その後、この混沌とした見た目の形状をワイングラス
オブジェクトに結合し、シートを使用してグラスを粉砕するブーリアン演算をセットアップします。

04 S を押して Select ツールを表示し、4 を押してプリミティブ選択
に切り替えます。シートの 1 つをダブルクリックして、シート全

体を選択します。Tab > Duplicate を押して、コピーを作成します。回転 (R) 
ハンドルを使用して、複製したシートの向きを変更し、他のシートとほぼ直
交させます。カップのみを切断し、ステムは避けるようにします。これにより、
カップが別の方向に割れ、よりリアルなガラスの破片を作成できます。

別のシートでも繰り返し、異なる角度で切断する別のサーフェスを作成し
ます。

01 Scene View でオブジェクトレベルに移動し、C を押して、
Create > Geometry > Grid を選択します。Enter を押して 

原点に配置したら、I で中に入って次のように設定します。
	� Orientation を YZ Plane にする
	� Center Y を 4 にする
	� Size X を 5 にする
	� Size Y を 8 にする
	� Rows を 16 にする

これにより、ワイングラスの形状に一致する、Draw Curve ツールのための
描画サーフェスが作成されます。

02 Right  ビューに移動し、V を押して Shading > Wireframe を
選択し、ワイヤーフレームモードにします。グリッドとワイングラ

スの背後に弾丸が見えます。N を押してグリッド全体を選択し、Create シェ
ルフの Draw Curve ツールをクリックします。 

ワイングラスの上に、弾丸がガラスに当たる場所で交わるカーブを何本も
描画します。グラスのステム（脚）も粉々になる予定なので、ステムを横切る
カーブも追加します。不要なカーブを描いてしまったら、いつでも Ctrl + Z 
を押して取り消せます。

03 Select ツールに移動し、N を押してすべてのカーブを選択しま
す。次に、C を押して、Model > Polygons > PolyExtrude を

選択します。Divisions を 4 に設定します。

Extrusion タブで、次のように設定します。
	� Transform Extruded Front をオンにする
	� Transform Space を Global にする
	� Translate X を -4.5 にする

次に、別の箇所をクリックしてからすべてのジオメトリを選択し、Tab > 
Transform を押します。Translate X を 2.25 に設定して、このジオメトリ
を原点周辺の中央に配置します。
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BOOLEAN SHATTER
Boolean ノードは、ほとんどの場合、加算、交差、減算といった従来のブーリアンを
作成するのに使用されます。これらは閉じた形状にはうまく機能しますが、Shatter 
オプションを使用すればシートでジオメトリをスライスできます。
Houdini には Voronoi Shatter ツールもあり、使用することができますが、割れた
ガラスに必要なギザギザなルックにはなりません。また、ガラスのような粉砕を作成
できる RBD Material Fracture ノードもありますが、これらは平坦なサーフェスで
の使用に最適な機能なので、このワイングラスのレッスンでは使用していません。

Boolean Shatter

Voronoi

RBD Material 
Fracture

05 すべてのジオメトリを選択し、Tab > Mountain を押して、 
さまざまなシートのポイントにノイズを追加します。Amplitude 

を 0.75 に設定します。グラスの破砕がより面白いものになります。

ネットワークビューで、Null ノードをチェーンの終端に追加し、その名前
を FRACTURE_OUT  に変更します。このノードに Display フラグを設定し
ます。 

オブジェクトレベルに移動し、このノードの名前を fracture_geo  に変更し、
Display フラグをオフにして非表示にします。

06 wine_glass  オブジェクトの中に入ります。ネットワーク
ビューで、Tab > Object Merge を選択し、ノードを配置しま

す。Object 1 の横にあるノードセレクタをクリックし、fracture_geo > 
FRACTURE_OUT に移動して、このノードを選択します。Transform が 
Into Specified Object に設定されていることを確認してください。

これにより、ノイズを含むシートがワイングラスジオメトリネットワークに 
追加され、グラスを Boolean で Shatter できるようになりました。

07 ネットワークビューで Tab > Boolean を選択し、クリックして 
新しいノードを配置します。Subdivide  ノード（GLASS_OUT  で

はありません）を 1 つ目の入力に接続し、object_merge  を 2 つ目に接続
します。その Display フラグを設定したら、次のように設定します。

	� Set B: Treat As を Surface にする
	� Operation を Shatter (Pieces of A) にする

破砕を確認するため、Exploded View ノードをチェーンの終端に追加しま
す。破砕する様子を変更したい場合は、fracture_geo  オブジェクトに戻っ
てシートを編集します。編集内容は、プロシージャルに更新されます。

08 ネットワークビューで、exploded_view  ノードをバイパスする 
Null ノードを追加し、その名前を GLASSFRACTURE_OUT  に

変更します。このノードに Display フラグを設定します。 

これで、このネットワークに 2 つの出力ノードができました。GLASS_OUT  
で元の形状のワイングラスが出力され、GLASSFRACTURE_OUT で破砕した
グラスが出力されます。これら両方を流れに沿って使用し、ショットを完成
させます。

作業内容を保存します。
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パート 4

RBD シミュレーションのセットアップ
シェルフツールを使用してリジッドボディシミュレーションを作成します。これにより、ジオメトリ、フォース、ソルバノードをまとめた  
DOP（Dynamic Operator）ネットワークが追加されます。ワイングラスのジオメトリネットワークには、シミュレーション用のジオメトリ 
準備のためのノードが追加されます。Convex Proxy を使用して、Bullet RBD ソルバが不規則なガラス破片を処理できるようにします。 

CONVEX DECOMPOSITION
RBD シミュレーションでは、高速シミュレーションを維持するために、
Houdini は 凸型形状を好む Bullet ソルバを使用します。Convex 
Decomposition では、凹型の形状をつながった凸型の形状に分解で
きます。その後、これらは Bullet ソルバによって 1 つの合成ピースとし
てシミュレートされます。 
ワイングラスの破片の形状はさまざまなので、Convex Decomposition 
によってすべての破片が正確に衝突するようにします。 元のジオメトリ Convex Decomposition

1
2

3 4

5

01 オブジェクトレベルで wine_glass  オブジェクトを選択し、
Rigid Bodies シェルフの RBD Convex Proxy ツールを 

クリックします。これにより、AutoDopNetwork  という初期ダイナミクス
ネットワークがセットアップされます。V を押して Shading > Smooth Wire 
Shaded を選択します。 

このツールを使用し、複雑な衝突の作成に使用できる凸状形状にワイング
ラスのパーツを分解します。ソースジオメトリよりも粗く表示されますが、 
シミュレーションの後で、クリーンなトポロジを確認できます。

02 Collisions タブに移動し、Ground Plane シェルフツールを 
クリックします。これにより、衝突するジオメトリ用に無限の 

地面が作成されます。 

groundplane_object  の Display フラグをオフにして、Scene View に 
表示されないようにします。それでもシミュレーションでは引き続き衝突 
するサーフェスとして機能します。

03 AutoDopNetwork  に入ります。wine_glass  ノードを選択
し、Physical タブで Density をガラスのおおよその密度である 

2000 に設定します。 

プレイバーで Play を押し、どうなるかを確認します。ガラスが地面に落下
します。現時点では、破片に作用する力は重力しかありません。

衝撃まで破片を接着しておく Glue ネットワークをセットアップしてもかまい
ませんが、弾丸は非常に高速なため、パーツの接着は不要です。

97

RB
D 

シ
ミ

ュ
レ

ー
シ

ョ
ン

の
セ

ッ
ト

ア
ッ

プ



05 オブジェクトレベルに上がって bullet  オブジェクトを選択し、
Rigid Bodies シェルフの RBD Objects ツールをクリックし

ます。弾丸からパックされた RBD オブジェクトが作成され、ダイナミクス 
ネットワークに追加されます。

AutoDopNetwork  に移動し、bullet  ノードを選択します。 
	� Initial State タブで、Velocity を 400, 0, 0 にする 
	� Physical タブで、Density を 20000 にする 

これは鉛の密度で、弾丸に適しているはずです。 

06 シミュレートする前に、グラスのプレートが地面に固定された
ままになるようにします。wine_glass  オブジェクトに移動し

て、ディスプレイバーでプリミティブ番号をオンにします。ここではプレート
のパックプリミティブは 171 ですが、皆さんのものはおそらく違っているで
しょう。

Attribute Create ノードを create_packed_primitive  と proxy_geo 
ノードの間に作成します。次のように設定します。

	� Group を !171（または皆さんのプレートの番号）にする
	� Name を active  にする
	� Value を 1, 0, 0, 0 にする   

07 次に、transform_hires  ノードの Display フラグをオンにして、
Global Animation Options を開き、End を 50 に設定します。 

シミュレーションを再生します。ソースジオメトリがプロキシに合わせてアニ
メートされているのが分かりますが、衝突はそれほどドラマチックではあり
ません。

08 ソルバでの弾丸シミュレーションでは、デフォルトのサブステッ
プは 10 です。これは、弾丸のスピードの衝突を解決するのに

十分ではありません。オブジェクトレベルに上がり、AutoDopNet  ノードで 
Substeps を 5 に設定します。これで、ソルバ設定でサブステップが追加さ
れます。これによりシミュレーション時間が長くなりますが、正確さが増すう
えに、たいていはシミュレーションがよりアクティブになります。

シミュレーションをもう一度再生して、衝突の様子が改善されていることを
確認します。何か変更したい場合は、戻って設定を調整します。戻って一部
の亀裂の位置を変更してもかまいません。

作業内容を保存します。

04 オブジェクトレベルに上がって wine_glass  オブジェクトに入り
ます。たくさんのノードを追加してプロキシジオメトリを作成して

おり、このチェーンは現在表示されている dopimport  ノードで終わります。 

convexdecomposition  ノードで、Max Concavity を 0.05 に変更して 
衝突ジオメトリを調整します。 

Play を押してシミュレーションを確認します。
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01 フレーム 1 に進みます。ネットワークビューで wine  オブジェ
クトを選択し、Particle Fluid シェルフの FLIP Fluid from 

Object ツールをクリックします。 

すると、流体が流体パーティクル群になります。AutoDopNet  で、
flipfluidobject  ノードを選択し、Particle Separation を 0.05 に設定し
ます。これによりパーティクルが増え、シミュレーションにディテールが加わ
ります。

02 flipsolver1  ノードを選択して Particle Motion タブをクリック
し、Behavior で次のように設定します。
	� Add ID Attribute をオンにする 

Reseeding で次のように設定します。
	� Reseed Particles をオフにする 

Volume Motion で次のように設定します。 
	� Velocity Transfer を (APIC) Swirly にする

Surface Tension で次のように設定します。
	� Enable Surface Tension をオンにする
	� Surface Tension を 500 にする

03 Play を押してシミュレーションを実行します。追加のサブステッ
プのため時間は少し長くかかりますが、より正確な結果が得ら

れます。フレーム 10 を過ぎたら、Escape を押してシミュレーションを止め
ます。フレーム 10 に移動して、ここまでの流体をプレビューします。 

これをサーフェスとして表示するには、オブジェクトレベルに上がって 
wine_fluid  オブジェクトに移動します。Render Null ノードに Display フ
ラグを設定すると、サーフェス化された流体を確認できます。これはクック
するのに長い時間がかかりますが、サーフェスがどのように見えるかをフ
レーム毎に確認することができます。

パート 5

シミュレーションへ流体を追加
弾丸によるグラスの粉砕ができたので、ワインオブジェクトを流体に変換し、シミュレーションの一部として統合します。 
つまり、RBD と流体シミュレーションを同一 DOP ネットワークにまとめ、1 つのシステムとして動作するようにします。 
最初は、流体はパーティクルで表現されますが、サーフェス化して流体を視覚化できます。

Display フラグとレンダーフラグ
wine_fluid ジオメトリネットワークが最初に作成されたとき、
Display フラグはパーティクルを表示する dopimport ノードにあ
りますが、レンダーグフラグは particle surface ノードから生じた 
Null ノードにあります。このセットアップにより、ビューポートでのパ
フォーマンスが高速になり、レンダリングした場合は最終的なサー
フェスを確認できます。このレッスンでは、サーフェスをキャッシュ化
するため、ノードはレンダリングに使用されません。
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パート 6

シミュレーションのキャッシュ化とリタイム
このショットでは、10 フレームのシミュレーションを計算します。これをディスクに保存したら、Retime ノードで、流体が減速してから 
時間が逆戻りする長いショットに伸ばします。リタイムされた流体パーティクルがサーフェス化され、レンダリングのための最終ショットを
定義する 50 フレームのシーケンスとして出力されます。その後、ワイングラスと弾丸も流体に合わせてリタイムします。

01 オブジェクトレベルで、シェルフツールで作成した wine_fluid_
interior  ノードを削除します。wine_fluid  オブジェクトに入っ

て、import_wine、compressedcache  ノード、particlefluidsurface  ノー
ドを除くすべてのノードを削除します。 

compressed_cache  で次のように設定します。
	� Base Name を wine_fluid  にする
	� Base Folder を $HIP/geo/fluid/  にする
	� Version チェックボックスをオフにする
	� End を 10 にする（最初に RMB クリック > Delete 

Channels）

Save to Disk を押します。

02 完了したら、ジオメトリレベルのまま、Scene View の右上に 
ある Visibility メニューから、Hide Other Objects を選択し

ます。 

Load from Disk をオンに設定して、ジオメトリシーケンスをスクラブしま
す。10 フレームのみ再生します。これからシーケンスをリタイムし、50 フレー
ム以上に伸ばしてエフェクトを減速します。

03 compressed_cache  ノードの後に Retime ノードを追加して、
Display フラグを設定します。次のように設定します。 
	� Evaluation Mode を By Frame にする
	� Scale Velocities オプションをオンにする

Frame フィールドで RMB クリックし、Delete channels を選択します。 
	� フレーム 1 : Frame を 1 に設定し、Alt クリック してキーフ

レームを設定
	� フレーム 5 : Frame を 1 に設定してキーフレームを設定
	� フレーム 10 : Frame を 7 に設定してキーフレームを設定
	� フレーム 40 : Frame を 10 に設定してキーフレームを設定
	� フレーム 45 : Frame を 1 に設定してキーフレームを設定

04 Animation Editor ペインをクリックして、作成したアニメーショ
ンカーブを確認します。グラフ上で H を押してビューをホーム

し、RMB クリックしながらドラッグして少しズームアウトします。

カーブハンドルをクリックアンドドラッグし、この図と同じような形状にしま
す。カーブの接線を分割する必要がある場合は、キーを選択し、T を押して
接線を統一します。次に、それぞれの端を個別に選択してドラッグします。
ここでの目標は、液体が素早く飛び出した後、ゆっくりになって短時間止ま
り、その後スピードアップして元の形状に素早く戻るようにすることです。
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リタイム
ワイングラスの粉砕で一番面白い部分は、最初の 10 秒間です。シミュレーショ
ンのこの部分を強調するため、10 フレームの流体パーティクルを保存してから、
Retime ノードを使用してシーケンスを伸ばします。時間を逆戻りさせて元のワイン
グラスに戻す、一種の「バレットタイム」効果を作成します。 
これを流体に設定したら、ポイントをサーフェス化して、長いシーケンスを保存しま
す。同じ Retime ノードは、粉砕するグラスと弾丸にコピーアンドペーストして使用
できます。

08 フレーム 1 に行き、wine_glass  ネットワークに移動します。
transform_hires  ノードの下に、File Cache ノードを配置して

接続し、次のように設定します。 
	� Base Name を glass_pieces  にする
	� Base Folder を $HIP/geo/  にする
	� Version チェックボックスをオフにする
	� End を 10 にする（最初に RMB クリック > Delete 

Channels)

Save to Disk を押します。Load from Disk をオンに設定したら、フレーム 
1 から 10 までをスクラブして、正確に見えることを確認します。

05 Retime  ノードが particlefluidsurface  ノードに接続されて 
いることを確認し、Display フラグを設定します。これにより、 

リタイムをベースとした最終的な流体が得られます。particlefluidsurface  
ノードを選択して次のように設定します。

	� Method を Average Position にする 
	� Union Compressed Fluid Surface をオフにする

Filtering タブで次のように設定します。
	� Dilate をオンにし、2 にする
	� Smooth をオンにし、Laplacian Flow にする

06 チェーンの終端に USD Export ノードを追加します。それを 
wine_surface  という名前に変更します。次のように設定し

ます。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/wine_surface.usd  にする 

Save to Disk  を押します。

07 Retime  ノードを選択し、Ctrl + C を押してコピーします。別の
ネットワークでこれをペーストして、砕けるワイングラスをリタイ

ムします。これにより、両方のネットワークでキーフレームが一致します。 

作業内容を保存します。
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USD と SOLARIS
このプロジェクトのルックデベロップメント工程をサポートするため、流体、ワイングラ
ス、弾丸を USD にキャッシュ化します。こうすることで、シミュレーションの再計算を 
気にすることなく、レンダリングに集中できるようになります。ここではシミュレーション
と同じシーンファイルにキャッシュを表示しますが、新しいシーンファイルにキャッシュを
インポートしてもかまいません。こうするとショットのライティングとレンダリングに集中
できますが、シミュレーションに戻って微調整するのが大変になります。

09 Ctrl + V を押して Retime  ノードをペーストし、それを 
filecache  ノードの後に配置して Display フラグを設定します。

これで流体とグラスでタイミングが一致しました。タイムラインをスクラブし
て、破片のタイミングを確認します。

Retime  ノードの後に、Attribute Delete を追加します。Primitive 
Attributes の横にある矢印から、name  を選択して、ジオメトリから 
このアトリビュートを削除します。

10 Switch ノードをネットワークに追加します。GLASS_OUT、 
それから attribdelete  ノードをそれに接続します。 

Select Input を $F>5 && $F<45  に設定します。タイムラインでスクラブし
て、その動作を確認します。このエクスプレッションは、フレーム 5 でひび割
れのないグラスから割れたグラスに切り替わり、フレーム 45 で元に戻るよう
にするものです。

これらの形状をまとめて、ワイングラスの USD ファイルで、衝撃の前後は 
グラスが割れていないようにします。

11 チェーンの終端に USD Export ノードを追加します。次のように
設定します。
	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/wineglass.usd  にする 

Save to Disk を押します。

12 フレーム 1 に移動し、bullet  オブジェクトを選択します。
Modify メニューから Extract を選択します。これにより、ジオ

メトリのワールド空間位置を取得できます。extract_object  の中に入り、
retime  ノードを object_merge  ノードの下にペーストして、それらを接続
します。 

チェーンの終端に USD Export ノードを追加します。それを bullet  という
名前に変更します。次のように設定します。

	� Valid Frame Range を Render Frame Range にする 
	� Output File を $HIP/usd/bullet.usd  にする 

Save to Disk を押します。
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シミュレーションのキャッシュ化
このプロジェクトのルックデベロップメント工程をサポートするため、流体、ワイングラ
ス、弾丸をジオメトリ（USD）シーケンスにキャッシュ化しました。こうすることで、シミュ
レーションの再計算を気にすることなく、レンダリングに集中できるようになります。 
大量のハードディスク容量を消費する VFX ショットでは、こうしたワークフローが一般
的です。たくさんのパーティクルを含む巨大なシミュレーションを送る際は、この点に注
意するようにしてください。さまざまな中間段階を保管できる場所を確保することが重
要です。

01 デスクトップを Solaris に変更します。パスバーで Stage を選
択します。 

ネットワークビューで Tab > Reference を選択してからクリックし、
Reference ノードを追加します。Reference File の横にある File 
Chooser をクリックして、wineglass.usd  ファイルを指定します。ノードの
名前を wineglass  に変更します。Primitive Path を /geo/$OS  に設定し、
ノード名を使用して、geo  というグループに配置されるようにします。

Scene View で、ビューをホームするスペースバー + H のような表示ツール
を使用して、ワイングラスがよく見えるようにします。

02 このノードを Alt ドラッグして複製し、さらにもう 1 つ複製しま
す。1 つ目のコピーで、File Chooser をクリックして wine_

surface.usd  ファイルを指定します。ノードの名前を wine  に変更します。

2 つ目のコピーでも同じことを行い、bullet.usd  ファイルを指定します。 
ノードの名前を bullet  に変更します。 

ネットワークに Merge ノードを追加して、3 つすべての参照ノードをそれに
接続します。Display フラグを設定したら、スクラブして結果を確認します。

シーングラフには、geo  エントリの下に 3 つの参照 USD ファイルが表示さ
れているはずです。

03 ネットワークビューで、Tab を押して Grid と入力します。 
クリックしてノードを配置したら、名前を backdrop  に変更して、

Merge  ノードに接続します。Import Path Prefix を /geo/$OS  に設定しま
す。backdrop  ノードをダブルクリックして、ジオメトリレベルに入ります。  

Grid  ノードを選択し、Size を 200, 200、Rows および Columns を 20 
に設定します。Grid  ノードの出力を RMB クリックして、Bend と入力しま
す。クリックして Bend ノードを配置したら、Display フラグを設定します。
Bend を 75、Capture Origin を -40、0、0、Capture Direction を -1、0、0、
そして Capture Length を 20 に設定します。Grid  ノードの出力を RMB ク
リックして、Subdivide と入力します。Display フラグを設定し、Depth を 
2 に設定します。

パート 7

ショットの設定とレンダリング
ショットのレンダリングには、USD ファイルを Solaris ステージで参照し、背景を追加します。Solaris は Houdini のコンテキストで、 
LOP ノードを使用して USD シーングラフを定義します。次に、カメラを配置し、環境ライトを追加します。その後、ビューポートで Karma 
レンダラを実行し、ショットのプレビューレンダリングを行います。
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ビューポートレンダリング
Houdini のレンダラである Karma を使用して、シーケンスをレンダリン
グします。はじめは、Display Options の設定でレンダリングを実行し
ます。Display Options を表示するには、Scene View で D を押します。
デノイザをオンにしたり、Pixel Samples や Image Resolution の設定
が可能です。  
その後、Karma LOP をセットアップすれば、最終出力はそのノードの 
レンダリング設定で実行されます。

Denoiser を 
オンにする

04 表示ツールを使用して、正面から wineglass  が見えるようにし
ます。LOP Lights and Camera シェルフで、Camera ツール

を Ctrl クリックします。ネットワークに Camera ノードが加わり、カメラ越し
にビューポートを見られるようになります。 

Lock Camera/Light to View ボタンを押し、ビュー変更に応じてカメラの
位置が更新されるようにします。ビューポートでタンブル、パン、ドリーして
カメラを再配置し、ワイングラスが左側にきて、しぶきは右側に飛ぶように
します。タイムラインをスクラブし、シーケンス全体でカメラが機能している
ことを確認します。

05 LOP Lights and Camera シェルフで、Camera ツールを  
Ctrl クリックします。Domelight  ノードをチェーンの終端に追

加します。

Domelight  ノードを選択し、Base Properties タブで Texture の横にある 
File Chooser  ボタンをクリックします。サイドバーで $HFS/houdini/
pic/hdri  リストをクリックして、HDRIHaven_skylit_garage_2k.rat  ファ
イルを選択します。Accept をクリックします。

Display Options バーで、High Quality Lighting with Shadows ボタ
ンをクリックします。

06 Persp  メニューで Karma を選択し、ビューポートで Karma を
使ってレンダリングします。タイムラインで異なるフレームに移

動すると、ビューポートが素早く更新されます。

Karma は USD を使用するよう設計されているので、LOP コンテキストの
すべてが USD シーングラフに変換されます。Houdini のこの部分からのみ 
Karma レンダラを使用できます。 

07 レンダリング時によりクリーンな画像を得るには、Nvidia グラ
フィックカードがあり、最新のドライバをインストールしている場

合は Denoiser をオンにします。Denoiser は、Display Options でオンに
できます。
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シーングラフ
ジオメトリやライトと同じように、LOP ノードを使用して追加し
たマテリアルはシーングラフに追加されます。Material Library 
LOP を使用したとき、Material Path Prefix のデフォルト設定は 
/materials/ でしたが、それはグラフでのマテリアルの位置でもあり
ます。編成を変えることも可能ですが、これがデフォルトです。
このマテリアルパスは、マテリアルをジオメトリに配置するために 
Assign Materials LOP で使用したパスです。

01 ネットワークビューで Tab > Material Library を押します。 
それをチェーンの終端に接続し、Display フラグを設定します。

Material Palette ペインに移動します。/stage/materiallibrary  の横に
ある矢印をクリックし、このエリアを開きます。パレットの左側のマテリアル
ギャラリーをスクロールして、ワイングラスとワイン用に Glass マテリアルを 
2 つ materiallibrary  作業エリアにドラッグします。

次に Copper マテリアルを見つけ、materiallibrary  作業エリアにドラッグ
します。これは弾丸に使用します。

02 2 つ目の Glass  マテリアルを選択し、名前を wine  に変更し
ます。 

ワインの IOR である Inside IOR を 1.3443 に設定します。 
次に、Reflectivity を 0.2 に設定し、環境の反射率を下げます。 

Transmission Color を 0.2, 0, 0 に設定して、赤みがかったワインの色に
変更します。それから At Distance を 0.3 に設定します。

03 ステージレベルに戻ります。Material Library の後に Assign 
Material ノードを追加します。

シーングラフから wineglass  を Primitives フィールドにドラッグしたら、
Material Path の横にある矢印をクリックして、このプリミティブ用に  
glass  マテリアルを選択します。 

次にチェックボックスの横にある +（プラス）記号を 2 回クリックして、2 つ
の新しいエントリを追加します。同じ方法で wine  マテリアルを wine  プリ
ミティブに割り当て、copper  マテリアルを bullet  プリミティブに割り当て
ます。

パート 8

マテリアルの割り当てとシーケンスのレンダリング
最後に、ワイングラス、ワイン、弾丸にマテリアルを追加します。これらのマテリアルは USD シーングラフの一部となり、 
LOP ノードでジオメトリに割り当てられます。次に、Karma LOP で、Nvidia Optix Denoiser を含むレンダリングの設定を行い、 
レンダリング後、シーケンスを MPlay にロードし、結果を確認します。
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まとめ
Bullet RBD と FLIP 流体ソルバを使用して、ワイングラスを粉砕する  
VFX ショットを完成させました。Retime ノードを使用して、速度を落として 
から時間を逆戻りさせ、ワイングラスが最初と同じ位置に戻るようにしました。
そして結果を USD ファイルにキャッシュ化しました。 
その後、Solaris/LOPS コンテキストを使ってショットを設定し、ライトを追加
しました。マテリアルを作成してプリミティブに割り当て、ショットに適切な外
観を得ることができました。 
このプロジェクトでは、Houdini のダイナミクスノードとネットワークを使用 
してさまざまな種類のエフェクトを統合したり、ジオメトリノードを使用して 
シミュレーションのセットアップと出力を行う方法を紹介しています。 
VFX ショットの作成に使用されるノードとネットワークを理解できたら、
Houdini をさらに深く探求し、独自のエフェクトを作成してください。 
楽しむことが一番です!

05 ビューポートの Denoiser はこのノードからの出力に影響しな
いので、明示的に選択します。karmarendersettings  ノード

を選択して、Image Output > Filters タブで Denoiser を nvidia Optix 
Denoiser に設定してデノイザをオンに戻します。

nVidia Optix Denoiser がビューポートで使用されるものと一致します。
Intel OIDN デノイザもありますが、ディスクにレンダリングする場合のみ 
利用可能です。

作業内容を保存します。usdrender_rop  ノードを選択して、Render to 
Disk をクリックします。 

04 ネットワークビューで、Tab > Karma を押し、Karma Render 
Settings と USD Render ROP ノードを追加します。それらを

チェーンの終端に接続します。karmarendersettings  ノードを選択して、
Image Output > Filters タブで Denoiser を nvidia Optix Denoiser に
設定してデノイザをオンに戻します。

usdrender_rop  ノードを選択します。Valid Frame Range を 
Render Frame Range に設定し、Output Picture を $HIP/render/
wineglass_$F4.exr  に設定します。名前の $F  は、レンダリングにフレーム
番号を付加するのに必要で、4  はフレーム番号のパディングです。 

06 完了したら、Render > Mplay > Load Disk Files を選択し、 
レンダリングした画像を開いて最終的なシーケンスを確認し

ます。 

後で別の Karma ノードを分岐させて、解像度とレンダリング設定を上
げて最終的なレンダリングを行います。Convergence Mode に戻って 
Variance に設定し、サンプル数を上げ、デノイザをオフにします。 
最初は低解像度でテストレンダリングを行い、すべてが希望通りになって 
いることを確認するようにしてください。
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